9/27/2018 Word Day 3

Microsoft Word Day 3
Format Spaces

Double space a paragraph
Create a bulleted list

To add a border

To add shading

Add Indents

Insert and size picture from Online Pictures
Insert a symbol

Use Find and Replace

Create a header and a footer
Use Spell Check

Use print preview
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World Travel Inc:

The spaces around your text and images are very important to your document. Crowded lines are hard to read. Open space can draw the
eye to the important parts of your text.

In this lesson you will learn to format the spaces that exist by default. Later you will learn how to manage the size of the spaces.

With Word you can create automatic lists that are numbered or that use a symbol at the left. You can color the background of the page
or just part of it. You can surround areas with borders.

Cail & 5556547 for our special pricing,

Dont bo foft out! Sign p mow!
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e Click anywhere in first paragraph lines (8-9)
e Select the Home or Page Layout tab (either one will work)
+ Click the Small Dialog Box Launcher for the Paragraph Group

Paragraph dialog
box launcher

« Under Line Spacing - Select Double
« Click OK
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o ** Note you do not have to have the paragraph highlighted to take effect
o You can also use your keyboard CTRL + 2
=L
o You can also use t.tl'éu_t:‘ Line Spacing Command in the Paragraph group.
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Line Spacing Options...
4 Add Space Before Paragraph
% Remove Space After Paragraph
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Paragraph £
Bullets

Start a bulleted list.

Click the arrow to choose different
bullet styles.

o Select the lines with the list of trips

e Click on the 1= .bullets in the Paragraph group

« You can change the style of bullets
o Click the down arrow next to the bullets

o or Right click - Bullets

You can even customize it so your bullet is a picture if you want
o Choose Define New Bullet at the bottom
2/9
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o Select Picture then look through bullets and select one you would like
o Click OK on Picture Bullet menu
o Click OK on Define New Bullet menu

Define New Bullet

Bullet characker
’ Symbal... ] ’ PFicture... ] ’ Font... ]
. . Alignment:
|i==li= - o | 2= 5| S0 A;;;; 5 Aa Left v
Bullet Library Ereview
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Document Bullets
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Define Mew Bullet.. e ] [ cancel
o Select the lines with the list of trips
o Select the Design, then Page Borders within the Page Background group
BH S O- Documentl - Word DRAWING TOOLS T H - 8 X
FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW ADD-INS FORMAT Jodi Brown -
Aa Tite TITLE e Title TITLE Title Title the TITLE mE Title Title ;‘ Paragraph Spacing =
j Sl e [T o e : e [@] Effects - D @ D
Themes P it e e e — [—| Colors Fonts Watermark Page Page
- — - - - @ Set as Default - Color - Borders
Page Background ~

Document Formatting

Borders and Shading E|ri|

Borders | Page Border Shading
Setting: Style: Preview
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Click on the Borders tab
Select Shadow from the Settings List
Change the color to Red-Accent 2-Darker 25%, by clicking on the drop down arrow

« Change the width to 2 1/4 pt
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o Apply to: Paragraph
e *DO NOT HIT OK YET! Go to next step first!

o Click the Shading tab from the Borders and Shading Menu

Page
o If you closed it- Click 5°"“¢" the Page Borders button
« Change the color to White, Background 1, Darker 15% from color options (Row 3 Column 1)
o Apply to: Paragraph
« Click OK

H Save Changes (CTRL+ S)

| Borders | Bage Border ?udn;.
Fl

| —
54 Theme Colors |
H EEmEEEN

[ white, Background 1, Darcer 15% |
T

Standard Colors |
[ 1 PEEEEN

o Color l

More Calors... I

« Highlight the bulleted list (Line 12-14)
+ Select the Page Layout tab and open the Paragraph Dialog Box Launcher

Paragraph dislog
box launcher

e Under the Indentation Section
o Change Left Indent to 0.5"
o Change Right Indent to 0.5"

Indentaticn
Left: o5 =] Spacal: By:
Bht: o5 [Honging =] Jo25 =
Sparing
Before: o = Lige spacing: At
Alfte: o = [sege =] | =
r
e Click OK

« Place your cursor on line 3: click in between World Travel Inc. and Anniversary Specials (the blank line)

¢ Select Insert-Online Pictures
E | INSERT | DESIGN  PAGELAYOUT  RE

D E @ ’_z>|_| T SmartArt

. A 10 Chart
Table Pictures Online Shapes
- Pictures = &4 Screenshot -

Tables Illustrations

o In the search box type: suitcase
« Select show all web results
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» Click on the picture and select insert OR double click the picture you want to insert in your document
Modifying the picture

o Select the image in the document by clicking on it. Handles appear at the corners and in the middle of each side. When your picture is selected you will notice the Picture
Tools/Format Ribbon automatically appears.
o From here you can change the size, color, style, add borders and much more. Let's take some time to modify our picture and become familiar with these features.
« Move your pointer to the bottom right corner handle until it changes to the Diagonal Resize shape. ™

Dragging with a corner handle changes the width and height at the same time without changing the proportions of the image.

Centering the picture

The easiest way to Center your picture is to select the Home tab and click on the Center button in the Paragraph section. Make sure your picture is selected when doing
this!

+ Make sure size is appropriate - document still fits on one page

. H Save Changes (CTRL + S)

e Place your cursor after the word call and before the phone number in Line 16
Call | 555-6543 for our special pricing.

« Select the Insert Tab, click the Symbol command and at the bottom choose More Symbols e — ]
aree | TC T
Eonrion Syt [P iie ] )i &
- L E=00MNEEEa
o a| ¥ [a[e]a[=[=[4[F[B]: [Re
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: s 41 L oo |
 The symbol box appears, now Change Font to Wingdings | ottt | susotie _ |
ol [
o Select a picture of a Phone (choose one of the two)ﬂ—!-
o Click Insert
¢ Click Close

Add a space after the symbol

We want to replace all occurences of the word clients to customers.

Find and Replace

e Go to the top of your document; CTRL + Home

Fnd  Regisce | goTa |
e Go to Home - Replace

Fid wht [== =]
%
Replacs with: Joustossenes -
3l_ % 2 Find -
[ pegiace | Repice | [ Endnea cose | = 43 Replace

_ Change
T Styles- || M Select -

Editing
1
In the Find field type: clients
In the Replace field type: customers
Click Replace All
Word has made 1 replacement - Click OK
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o Click Close

. H Save Changes (CTRL + S)

e Go to Insert - Header (located in the Header & Footer Group) - choose Blank (the first one).
o Notice the view changes, allowing you to type only in the Header or Footer. The Ribbon changes as well give you options for your Header & Footer.

@ E - ¥ = Documentl - Word T EH - b 4
FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW ADD-INS Jodi Brown =
B CoverPage-~ D o ’__l:' T smartart & store W E’j &5 Hyperlink \__,_| [T Header ~ A Quick Parts - [ Signature Line - T[ Fquation e
D Blank Page T ol ~ 1.l Chart e e % |" Bookmark Built-in «|iymbol =
T Table  Pictures Online Shapes 3 Wy Apps ~ Wikipedia Online Comment |
'— Page Break - Pictures ~ ¢+ ocreenshot~ Ll b Video EI._:| Cross-reference Blank
Pages Tables Ilustrations Apps Media Links Comments |wmbals e

[Ty eee]

Rlank [Three Colimns)
+ Create your proper paper heading in the header

BEH S O - Documentl - Word HEADER & FOOTER TOOLS
FILE HOME INSERT DESIGM PAGE LAYOUT REFEREMCZES MAILINGS REVIEW VIEW ADD-INS DESIGM
D D ET“ Eﬂ |;| o o] |-_| [E1q Previous Different First Page L+ Header from Top:  |0.5" . a
- - - = [ Next Different Odd & Even Pages "t Footer from Bottam: |0.5" .
Header Footer Page Date & Document Quick Pictures Online Goto Goto ) _ X ) Close Header
- +  Numberr Time Infor Parts~ Pictures Header Footer Link to Previous || Show Document Text Insert Alignment Tab and Footer
Header & Footer Insert Mavigation Options Pasition Close
FACTS First Name | Last Name
Period # Date
Travel Flverl

EEZ

Type FACTS

Press the tab key twice to move you to the right side of the heading
Type your First and Last Name

Press Enter

Type Period #

Press the tab key twice to move you to the right side of the heading

Date &
Time
o Go up to the Ribbon and locate the Insert group. Press Insert Date

j
o
0O 0 0 0 O ©°
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o Select the style of date you prefer from the list provided in the Date and Time Box and press OK.

f Y
Date and Time @Iﬂ

Available formats: Language:

English United States) E la
Thursday, April 30, 2015
April 30, 2015

4/30/15

2015-04-30

30-Apr-15

430.2015

L Apr. 30,15

30 April 2015

»

April 15

Apr-15

4/30/2015 2:44 FM
4/30/2015 2:44:36 PM
2:44 PM

2:44:36 PM

14:44

14:44:36

= | [[] Update automatically

o) (o)
—

o Press Enter
o Press the tab key once to move you to the center of the heading
o Type Travel Flyer

Next, go to the Insert Tab and select Footer.

Now you are ready to type your footer. Press the tab key once to move you to the center of the footer
Type the word Flyer

Add one space

Type the word Page

Add one space
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o Now from the Insert Ribbon go to the Header and Footer Group and select Page Number-Current Position-Plain Number.
HOME  INSERT  DESIGN  PAGELAYOUT  REFERENCES — MAIUNGS  REVIEW  VIEW  AD

OB Bkl Bl kg B E g e

Header Footer  Page Date & Document Quick Pictures Online  Goto Goto

- *  Mumberr Time Info+ Pars~+ Pictures Header Footer Linkto Previous  |¥] Show Docum
Header & F E Top of Page p jert Navigation Optir
[& Bottom of Page »
F) Page Margins »
@ LCurrent Position 4 Simple =
Erg Eormat Page Numbers... Plain Number
B‘; Remove Page Numbers '
Plain Number
Murmber with no formatting or
accents
Page X
Accent Bar 1
T
Accent Bar 2
Fage |1
@ More Page Numbers from Office.com 3

. H Save Changes (CTRL + S)

@ HS O-
FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW
ABC = ABC LT = An
v B E afp A L '

Spelling & Define Thesaurus Word  Translate Language New  Delete Previous MNext Show

Grammar Count - - Comment Comments Er

Proofing Language Comments

Red Wavy lines Green wavy lines

e Go to the top of your document- CTRL + Home

» Select Review-Spelling & Grammar (or the F7 key on your keyboard)
» Change mispelled words by selecting the correct spelling from the list

o Click Ignore Once if it says you mispelled your name

. H Save Changes (CTRL + S)
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We will NOT Print this document
- print preview is to double check what it is going to look like IF we WERE going to print

e Go to the File - Print
e DO NOT HIT PRINT. JUST LOOK AT THE PREVIEW.

Print Preview should

appear here.

 Make sure document looks pleasing to the eye
e Click Close
o or ESC on keyboard

. H Save Changes

Basic/Level 2

Left Margin = 1" and the Right Margin = 1"
Change font style, size and color as instructed
Double space the paragraph

Create a bulleted list

Insert clip art and a symbol of a phone

Insert a proper page heading

Use spell check

Proficient/Level 3

» Add shading and a border around the list of trips as instructed
o Indent the bulleted list as instructed

» Use Find and Replace (change clients to customers)

e Add page numbers in the footer as instructed

Advanced/Level 4

o Create a border around the entire page

e Insert a 2nd picture from the internet (not clip art)

* Make sure everything fits on one page- you do NOT want a two page flyer
o Make sure your pictures and word do not overlap
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